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L ike it or not, Internet skills are
becoming more important for physi-
cians as patients go online to access
health care information. For these

patients, quality care often means helping
them sift through online information or rec-
ommending Web sites where they can go to
learn more about their diseases or condi-
tions. If you’re a physician who has relegated
the use of your computer to your support
staff, perhaps it’s time to reconsider it as an
evolving tool in patient care.

You can start by improving your skill
using your “Web browser.” If you’re like
most people, you probably don’t know how
to use your browser to its fullest capabilities.
This can be frustrating as you try to perform
Internet searches. In this article, I’ll give you

tips for supercharging your Web browser so
you can navigate the Web faster and search
it more effectively.

1. Choose your browser
A browser is a software program that helps
you communicate with the Internet. It
enables you to interface with the Web by
clicking menus or buttons. The two most
popular Web browsers are Microsoft’s Inter-
net Explorer and Netscape’s Communicator.
If you subscribe to Internet service provider
America Online (AOL), you’ll be encouraged
to use AOL’s browser; it’s really just another
version of the Netscape product. All three
browsers offer similar features and capabili-
ties, but they each use different terms to refer
to the same fea-
tures. For example,
Internet Explorer
stores links to Web
pages as “favorites,”
while Netscape
refers to them 
as “bookmarks.” 
(In this article, I will refer to features using
the nomenclature used in Internet Explorer,
version 5.0.) 

I have a strong preference for Internet
Explorer 5.0, in part because it’s the industry
standard, with about 80 percent of the desk-
top marketplace, but also because it has a
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number of useful features and can handle a
wide variety of Web page formats. 

If you want to start using a different
browser, you should be able to download the
software from the Web at no charge. Be aware
that any browser you install will try to take
over as your default browser, but you can pre-
vent this. For example, if, like me, you’d pre-
fer not to use AOL’s browser, you can run
Internet Explorer 5.0 on AOL instead. How?
Simply by turning on the Internet Explorer
software after you’ve connected to the Inter-
net via AOL. Internet Explorer will recognize
the connection and run just fine. And best of
all, you’ll avoid all those annoying advertise-
ments that are a constant part of the AOL
browser experience! 

2. Choose your home page
The first thing that will appear on your com-
puter screen after connecting to the Internet
is your home page. You can easily make any
Web site your home page. For example, go to
the Family Practice Management Web site by
typing the URL www.aafp.org/fpm in the

space labeled “address” at the top of your
browser. The FPM site features articles in full
text, including this one.

While the FPM home page is displayed
on your computer screen, click your mouse
on the Tools menu and then on the drop-
down item Internet Options. A dialogue 

box will open, asking if you want to change
the page you use for your home page. Click
on the Use Current button, then click on
Apply and then OK to close the dialogue
box. An even simpler way to change your
home page is to highlight and drag any URL
from the address space at the top of your
browser to the Home icon on your toolbar.
It’s as easy as that. 

3. Reconfigure your toolbars 
Is there so much clutter at the top of your
browser that it’s invading your viewing
space? You can customize your display by
positioning your cursor anywhere in the gray
space surrounding the buttons that appear in
the toolbar near the top of your browser
window. Then, “right-click” your mouse
(i.e., use the right button on the mouse
instead of the left button) and a drop-down
menu will appear. Click once on the items
you want displayed. You can also add short-
cut buttons to your browser’s toolbar by
right-clicking in the gray space on the tool-
bar and choosing Customize on the drop-

down menu. A dialogue box will
appear showing all the buttons avail-
able. Simply click on the one you
want, click Add, repeat for any oth-
ers you want and click Close to close
the dialogue box. You should now
see these new buttons displayed on
your toolbar.

If the font on a Web page is 
too small for you to read on your
browser, you can enlarge it by going
to the View menu, choosing Text
Size and then selecting a more
appropriate text size. You can also
click on Full Screen under the View
menu to temporarily eliminate your
menu bar and toolbars so that more
of the Web page is displayed on your
computer screen. These features are
particularly useful when showing
Web pages to patients or colleagues
gathered around your monitor’s
small screen.

4. Keep your cyberspace organized
Perhaps you’ve recently seen several patients
who need information on end-of-life legal
issues, such as power of attorney or living
wills. On the Alzheimer’s Association Web
site, you’ve located a concise, one-page
description of the major legal documents
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these patients should discuss with
their attorneys, and you’d like to
be able to quickly locate this page
in the future to print out for
your patients. With Internet
Explorer, you can store the Web
page address (www.alz.org/care-
giver/guide/legal/legaldocs.htm)
as a “favorite.” To do this, open
the Web page and then click on
the Favorites menu. A drop-
down menu will appear. Simply
click on Add To Favorites, then
click on OK in the dialogue box
that appears and the Web page
will automatically be stored and
labeled for you. Whenever you
access Favorites, you will see an
item listed as Alzheimer’s Association Legal
Documents. Click on it and your browser
will retrieve that Web page for you.

If you’re not careful about organizing
your favorites as your collection grows, you
may find yourself with the digital equivalent
of that unsightly stack of papers sitting on
the corner of your desk. Fortunately, Web
browsers come loaded with features to help
you organize your favorites, and they’re flexi-
ble enough to allow you to re-organize them
as needed. For example, when the dialogue
box Add To Favorites is open in Internet
Explorer, you can: 

• Create and name a new folder to store
your favorites, 

• Name the Web pages you’re storing in
Favorites with a label of your own choosing,

• Opt to store the contents of the Web
page offline (i.e., store the page text and/or
pictures on your hard drive) by checking the
box Make Available Offline. This is particu-
larly useful for viewing documents when
you’re not able to connect to the Internet
(e.g., on an airplane). 

It makes a lot of sense to organize folders
by category. I have folders for health care
organizations, disease-specific Web sites,
patient-education materials and health 
care news and magazines, among others. 
I’ve also created folders within folders. 
For example, I have a main folder labeled
“eHealth resources” that contains a number
of subfolders for links related to “eHealth 
companies,” “eZines” and “personal health
records.” Using this system, I can store
hundreds of my favorite Web pages and 
can navigate them quite easily.

5. Search with Google 
A search engine is a Web-based program that
will help you search and retrieve specific
information from the Web. There are a lot
of search engines to choose from, but I like
and recommend the one at www.google.
com. The reason is simple: Google, despite
its funny name, is a no-nonsense power-
house of a search engine that delivers up-to-
date links to Web sites and uses an
intelligent ranking system to find “hits” that
most closely match search terms. Google
consistently puts what I’m looking for near
the top of the hit list, decreasing the time I
spend scrolling through the list.

To use Google, go to www.google.com
and type your search terms in the window at
the top of the page. Better yet, make Google
your default search engine by downloading
it onto your Web browser (for instructions,
go to www.google.com/options/defaults.
html and click on “Make Google your
default search engine”). I also suggest adding
the Google toolbar to your browser. Simply
go to www.google.com/options/toolbar.html
and click on the “I want the Google toolbar”
button at the bottom of the page. Once
installed, a page will appear giving you
instructions on how to use the toolbar. The
Google toolbar offers a number of searching
conveniences. A drop-down list on the
search window allows you to see your most
recent searches and rerun them with a click
of your mouse. The icon labeled Highlight
on the toolbar lets you highlight search
terms within the documents so that you
don’t have to spend time reading through 
a document to locate information you’re
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looking for. And once you’ve located a Web
site, Google also gives you the option of per-
forming a totally new search for words or
phrases within a document or within the
Web site itself. To do this, simply open the
page that you want to search and click on
Search Site on the Google toolbar.

Quick tip. Have you ever wondered how
to find a word or phrase on a particular Web
page? It’s easy with Internet Explorer 5.0.
Once you’ve opened your browser, simply
click on the Edit menu and then select the
Find (On This Page) option. This will open
a dialogue box in your browser that will
enable you to locate a word or phrase on the
Web page you currently have open. The key
command Control-F will do the same thing.

It’s a great tool when you’re dealing with a
large document.

6. Use plug-ins
There are literally hundreds of software 
programs designed for use with browsers.
They’re called “plug-ins,” and once installed,
they add new functionality, multimedia or
audio-video capabilities to your browser (see
the box below for a list of examples). One
very useful plug-in program is Adobe Acrobat
Reader (available free at www.adobe.com/
products/acrobat/readermain.html). Once
downloaded, Acrobat Reader permits your
Web browser to display highly formatted,
magazine-like pages that will print out with
page breaks in the right places. The format 

of these pages is known as PDF,
which, for the curious, stands
for portable document format. 

Although a growing number
of health-care-related documents
on the Web are PDF files, much
of the text and graphics you see
on a standard Web page are still
constructed and displayed in 
the simple text-editing format
known as HTML. You can print
out pages in HTML, but if
you’ve ever done it, you know 
it can get ugly! For one thing,
HTML isn’t too concerned
about where page breaks occur,
and when printing, text can be
disrupted or even lost. This
doesn’t happen with PDF files.
Perhaps their greatest value is
that they print out beautifully.
Acrobat Reader also has its own
set of controls for navigating
Web pages, zooming in or out
and finding words or phrases 
in the document.

Most Web sites that contain
PDF documents will ask you if

Adding plug-in software to your Web browser extends its useful-

ness, giving you the capability to do such things as watch video and

listen to audio. Most plug-in software is free and can be down-
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Adobe Acrobat Reader (available free at www.adobe.com/prod-

ucts/acrobat/readermain.html) allows you to view PDF files. These

highly formatted, magazine-like pages are used on many health-

care-related Web sites such as Morbidity and Mortality Weekly
Reports (www.cdc.gov/mmwr//mmwr_wk.html). Acrobat Reader is

also necessary for viewing and completing most Web-based forms.

QuickTime (available free at www.apple.com/quicktime) allows you

to hear music and other audio and watch video within a Web page.

Physicians will need QuickTime to use Web sites such as Loyola Uni-

versity Medical Center’s Visible Human Cross-Sections page (www.

meddean.luc.edu/lumen/MedEd/GrossAnatomy/cross_section).

RealPlayer (available free at www.real.com) lets you play stream-

ing audio, video and multimedia presentations on your Web 

browser. You’ll need RealPlayer to listen to National Public Radio

online (www.npr.org) or view video footage on news sites such 

as CNN (www.cnn.com/video).

Windows Media Player (available free at www.microsoft.com/win-

dows/windowsmedia/en/download/default.asp) is Microsoft’s

answer to RealPlayer and QuickTime and is used by online news

sites such as MSNBC.com.

Shockwave Player (www.macromedia.com/software/shockwave

player/) gives you access to multimedia, games, graphics, streaming

audio and interactive Web sites.

ESSENTIAL PLUG-IN SOFTWARE
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you’d like to download the Acrobat Reader
plug-in. Usually by clicking on an icon you
will automatically be taken to the Acrobat
Reader download page where a series of
prompts will help
you to download
the free software.
It may take a few
minutes to com-
plete the down-
load process, but
once installed, Acrobat Reader will automati-
cally open in your browser the next time you
choose a PDF file from a Web site.

The main drawback to using plug-ins is
that if you decide to upgrade or have to rein-
stall your browser software, you’ll probably
have to reinstall all of your plug-ins. Eventu-
ally this may change, as the companies that
make browsers begin offering incremental
upgrades rather than full installs.

7. Adjust your monitor’s color 
The readability of a Web page depends in
large part on the resolution of your comput-
er’s monitor. The higher the resolu-
tion, the more bits of color (called
“pixels”) are used in a graphic image
and the clearer the image. To make
sure you’re getting the best quality
image that your computer can pro-
vide, check your color settings. To do
this, left-click your mouse on the
Start button, then on Display. A dia-
logue box will appear. Click on the
tab labeled Settings. A page will
appear telling you whether your
computer is set to 16 Color, 256
Color, High Color (16 bit) or True
Color (24 bit or higher). Choose the
highest color level your monitor
offers. Then, click on Apply at the
bottom of the screen and continue to
answer “OK” to the questions in the
next few dialogue boxes until you
find yourself back where you started.
Images should now be sharper, colors
should be truer and it should be easi-
er to read what’s on your computer screen. 

8. Limit your cookie intake
As you travel through cyberspace, it’s impor-
tant to think about privacy and security.
You’re not alone out there. Cookies contain
information about you, your interests and
your buying habits. Web sites collect and use

this information to customize the services and
information presented to you on future visits. 

For example, if you inquire about a flight
schedule on an airline’s Web site, the site

might create a
cookie that con-
tains your itiner-
ary. Or it might
only contain a
record of which
pages within the

site you visited. Generally speaking, only the
information that you provide or the choices
you make while visiting a Web site are stored
in a cookie. 
The site cannot determine your e-mail name
unless you choose to type it, and if you do,
only the site that created the cookie can read
it. Allowing a Web site to create a cookie
about you does not give it, or any other site,
access to other information stored on your
computer. 

If you don’t want to be tracked while on
the Web, I recommend that you configure
your browser to alert you each time a Web

site you’re visiting wants to create a cookie
about you. This gives you the option of
agreeing to a cookie request or refusing the
offer. That way, at least you’ll know who’s
watching you!

To turn this feature on, go to the Tools
menu and select Internet Options from the
drop-down menu. Click on the tab for 
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Security along the top of the dialogue box,
and then click on the Internet icon to indi-
cate that you want to adjust your security
settings. Selecting the Custom Level at the 
bottom of the dialogue
box will cause a set of
radio-style buttons to
appear. Scroll down
until you see the cate-
gory Cookies and then
select Prompt under the
heading “Allow cookies
that are stored on your
computer.” Hit OK, then Apply, then OK
again and you’re done. The next time you go
to a Web site that wants to put a cookie on
your computer, you’ll be notified.

9. Take control of advertising 
My personal preference when browsing is 
to get rid of the advertisements and those
annoying blinking graphics, known as ani-
mated gifs. There are a number of plug-ins

that permit you to turn advertising and ani-
mated gifs on or off. My favorite is AdsOff!
Version 2.0 from Intercan Tech. This plug-
in is free and can be downloaded from

Intercan’s Web site (www.intercantech.
com). Once installed, it permits you to set
the level of ad filtering, from showing the
ads in full view to showing them only as
simple hypertext links to blocking them
completely. Filtering advertising helps 
your browser download pages much more
quickly, making your Internet connection
seem faster. 

AdsOff! 2.0 can also be set to block cook-
ies from Web sites that you know are trying
to track you. Simply supply AdsOff! with
the Web site’s URL and the plug-in will 
prevent tracking. 

10. Get to know your organization’s
computer staff
This final tip is really not a tip, but a 
precaution: Get advice and help with Web
browsers, downloads and plug-ins from 
the people who oversee your organization’s
computer network, if you have one. They
may want to supervise the installation of
browsers or plug-ins on network computers
so that they can ensure it’s done correctly
and that the security of the network isn’t
compromised. Most computer staff recog-
nize how important a tool the Internet can
be for physicians and will be glad to assist
you. After all, they’re not only computer
experts, they’re also someone’s patients. 
And like many patients today, they’re doing
their own medical research on the Web. 

Learning to use all the power under 
your browser’s hood can make the differ-
ence between quickly locating information
you want on the Internet and drifting 
aimlessly in frustration. Using even one 
of the tips in this article will enable you 
to begin navigating the Web faster and
more effectively.

Send comments to fpmedit@aafp.org.
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The following list of key commands works with both

Internet Explorer and Netscape Communicator. If you

use a Macintosh computer, substitute the Apple com-

mand key (the key with the apple icon and ) for

the Control key in the list below.

Key command Action

Control-A Select all

Control-B Organize Bookmarks/Favorites

(Windows) 

-B Edit Bookmarks

(Macintosh Netscape only)

Control-C Copy 

Control-N Open a new window

Control-O Open a new location

Control-P Print

Control-R Refresh/reload page

Control-S Save

Control-X Cut

Escape Stop 

Alt -F4 Close (Windows)

-W Close (Macintosh)

Alt -← Back (Windows)

-← Back (Macintosh)

Alt - → Forward (Windows)

- → Forward (Macintosh)

F10 Activate Menu Bar (Windows)

BROWSER SHORTCUTS


